
Question Paper Preview
   

 

Notations :

1.Options shown in green color and with  icon are correct.

2.Options shown in red color and with  icon are incorrect.

 

   

Subject Name : Office Executive

Creation Date : 2021-09-09 18:47:17

Duration : 90

Total Marks : 85

Display Marks: Yes

Share Answer Key With Delivery Engine : No

Actual Answer Key : Yes

Calculator : None

Magnifying Glass Required? : No

Ruler Required? : No

Eraser Required? : No

Scratch Pad Required? : No

Rough Sketch/Notepad Required? : No

Protractor Required? : No

Show Watermark on Console? : Yes

Highlighter : No

Auto Save on Console? ( SA type of questions will 

be always auto saved ) :
No

   

   

Office Executive
Group Number : 1



Group Id : 540626791

Group Maximum Duration : 0

Group Minimum Duration : 90

Show Attended Group? : No

Edit Attended Group? : No

Break time : 0

Group Marks : 85

Is this Group for Examiner? : No

   

   

General Awareness
Section Id : 540626998

Section Number : 1

Section type : Online

Mandatory or Optional : Mandatory

Number of Questions : 10

Number of Questions to be attempted : 10

Section Marks : 10

Enable Mark as Answered Mark for Review and 

Clear Response :
Yes

Sub-Section Number : 1

Sub-Section Id : 5406261199

Question Shuffling Allowed : Yes

   

Question Number : 1 Question Id : 54062620008 Question Type : MCQ Option Shuffling : Yes Is 

Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which ministry organised ‘Gender Samvaad Event 2021’, a joint attempt between DAY-NRLM and 

the Initiative for What Works to Advance Women and Girls in the Economy (IWWAGE) to create a 

common platform to share experiences emerging from this effort?



Options :

1.  Ministry of Health and Family welfare

2.  Ministry of Economic Affairs

3.  Ministry of Finance

4.  Ministry of Rural Development

   

Question Number : 2 Question Id : 54062620009 Question Type : MCQ Option Shuffling : Yes Is 

Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Covaxin, India's indigenous Covid-19 vaccine, is manufactured by:

Options :

1.  Sun Pharmaceuticals

2.  Bharat Biotech

3.  Aurobindo Pharma

4.  Serum Institute of India

   

Question Number : 3 Question Id : 54062620010 Question Type : MCQ Option Shuffling : Yes Is 

Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

According to the ‘Inclusive Internet Index 2021’ conducted by Facebook-Economist Intelligence 

Unit (EIU), India is at the _______ spot when it comes to internet inclusion and gender equality in 

accessing the internet.

Options :

1.  49th

2.  67th

3.  14th

4.  25th

   

Question Number : 4 Question Id : 54062620011 Question Type : MCQ Option Shuffling : Yes Is 

Question Mandatory : No Option Orientation : Vertical



Correct Marks : 1 Wrong Marks : 0.33

Among the following rivers, which one does NOT flow from the Aravali range?

Options :

1.  Banas

2.  Luni

3.  Pamba

4.  Sabarmati

   

Question Number : 5 Question Id : 54062620012 Question Type : MCQ Option Shuffling : Yes Is 

Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following Indian states does NOT share its border with Myanmar?

Options :

1.  Arunachal Pradesh

2.  Nagaland

3.  Manipur

4.  Andhra Pradesh

   

Question Number : 6 Question Id : 54062620013 Question Type : MCQ Option Shuffling : Yes Is 

Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

The city of CALCUTTA was founded in the year:

Options :

1.  1696

2.  1692

3.  1694

4.  1690

   

Question Number : 7 Question Id : 54062620014 Question Type : MCQ Option Shuffling : Yes Is 

Question Mandatory : No Option Orientation : Vertical



Correct Marks : 1 Wrong Marks : 0.33

Among the Bengali writers who was known as BANAPHUL?

Options :

1.  Balai chand Mukhopadhyay

2.  Peary Chand Mitra

3.  Sarat Chandra Chattopadhyay

4.  Bibhutibhushan Bandyopadhyay

   

Question Number : 8 Question Id : 54062620015 Question Type : MCQ Option Shuffling : Yes Is 

Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following consists the character ‘Chand Sadagar’?

Options :

1.  Manashamangal

2.  Chandimangal

3.  Kalikapuran

4.  Bishnupuran

   

Question Number : 9 Question Id : 54062620016 Question Type : MCQ Option Shuffling : Yes Is 

Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Please find the odd man out:

Options :

1.  Arayanok

2.  Pather Panchanchali

3.  Chander Pahar

4.  Devdas

   

Question Number : 10 Question Id : 54062620017 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical



Correct Marks : 1 Wrong Marks : 0.33

The character Panchak features in the drama:

Options :

1.  Achalayatan

2.  Dak Ghar

3.  Rakto Karobi

4.  Tasher Desh

   

   

Reasoning
Section Id : 540626999

Section Number : 2

Section type : Online

Mandatory or Optional : Mandatory

Number of Questions : 10

Number of Questions to be attempted : 10

Section Marks : 10

Enable Mark as Answered Mark for Review and 

Clear Response :
Yes

Sub-Section Number : 1

Sub-Section Id : 5406261200

Question Shuffling Allowed : Yes

   

Question Number : 11 Question Id : 54062620018 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the letter-cluster from among the given options that can replace the question mark (?) in 

the following series. 

 

RGA, TKG, VOM, XSS, ?



Options :

1.  WXZ

2.  XWY

3.  YXZ

4.  ZWY

   

Question Number : 12 Question Id : 54062620019 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Four pairs of letter-clusters have been given, out of which three are alike in some manner and one 

is different. Select the one that is different.

Options :

1.  DPL : HTP

2.  FKG : JPK

3.  RMC : VQG

4.  HFS : LJW

   

Question Number : 13 Question Id : 54062620020 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the option that is related to the third word in the same way as the second word is related to 

the first word. 

 

Beautiful : Pretty :: Funny : ?

Options :

1.  Impartial

2.  Hilarious

3.  Sincere

4.  Fragrant

   



Question Number : 14 Question Id : 54062620021 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

In a certain code language, NITIN is coded as PLXNT and VINOD is coded as FRRNB. How will 

KAPIL be coded as in that language?

Options :

1.  MKTEV

2.  LKSFR

3.  NLTFQ

4.  MNSFQ

   

Question Number : 15 Question Id : 54062620022 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the number from among the given options that can replace the question mark (?) in the 

following series. 

 

432, 352, 289, 241, ?

Options :

1.  179

2.  198

3.  206

4.  228

   

Question Number : 16 Question Id : 54062620023 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the option that is related to the third number in the same way as the second number is 

related to the first number. 

 

15 : 222 :: 20 : ?



Options :

1.  257

2.  298

3.  397

4.  408

   

Question Number : 17 Question Id : 54062620024 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

In a certain code, if '%' means 'addition', '@' means 'multiplication', '$' means 'division' and '&' 

means 'subtraction', then find the value of 182 $ 7 @ 2 % 29 & 7.

Options :

1.  23

2.  46

3.  74

4.  86

   

Question Number : 18 Question Id : 54062620025 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Ravi has Rs. 560 in the denomination of Rs. 5, Rs. 10 and Rs. 20 notes. The number of notes of each 

denomination is equal. What is the total number of notes that he has?

Note: For this question, discrepancy is found in 

question/answer. Full Marks is being awarded to 

all candidates.
Options :

1. 30

2. 45



3. 18

4. 54

   

Question Number : 19 Question Id : 54062620026 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the figure from among the given options that can replace the question mark (?) in the 

following series. 

 

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   



Question Number : 20 Question Id : 54062620027 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the correct mirror image of the given figure when the mirror is placed at AB as shown.  

 

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

   



Quantitative Aptitude
Section Id : 5406261000

Section Number : 3

Section type : Online

Mandatory or Optional : Mandatory

Number of Questions : 20

Number of Questions to be attempted : 20

Section Marks : 20

Enable Mark as Answered Mark for Review and 

Clear Response :
Yes

Sub-Section Number : 1

Sub-Section Id : 5406261201

Question Shuffling Allowed : Yes

   

Question Number : 21 Question Id : 54062620028 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 22 Question Id : 54062620029 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical



Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 23 Question Id : 54062620030 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 24 Question Id : 54062620031 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33



Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 25 Question Id : 54062620032 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 26 Question Id : 54062620033 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33



Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 27 Question Id : 54062620034 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Note: For this question, discrepancy is found in 

question/answer. Full Marks is being awarded to 

all candidates.
Options :

1.  

 

2.  

 

3.  

 



4.  

 

   

Question Number : 28 Question Id : 54062620035 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 29 Question Id : 54062620036 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Note: For this question, discrepancy is found in 

question/answer. Full Marks is being awarded to 

all candidates.
Options :

1.  

 

2.  



 

3.  

 

4.  

 

   

Question Number : 30 Question Id : 54062620037 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 31 Question Id : 54062620038 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   



 

4.   

 

   

Question Number : 32 Question Id : 54062620039 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 33 Question Id : 54062620040 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   



 

   

Question Number : 34 Question Id : 54062620041 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 35 Question Id : 54062620042 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 



   

Question Number : 36 Question Id : 54062620043 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 37 Question Id : 54062620044 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 38 Question Id : 54062620045 Question Type : MCQ Option Shuffling : Yes 



Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 39 Question Id : 54062620046 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 40 Question Id : 54062620047 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical



Correct Marks : 1 Wrong Marks : 0.33

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

   

General English
Section Id : 5406261001

Section Number : 4

Section type : Online

Mandatory or Optional : Mandatory

Number of Questions : 20

Number of Questions to be attempted : 20

Section Marks : 20

Enable Mark as Answered Mark for Review and 

Clear Response :
Yes

Sub-Section Number : 1

Sub-Section Id : 5406261202

Question Shuffling Allowed : Yes

   

Question Number : 41 Question Id : 54062620048 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical



Correct Marks : 1 Wrong Marks : 0.33

Select the most appropriate suffix to fill in the blank. 

 

The doctor advised the mother, “Give him a spoon _____ of this syrup if his temperature increases.” 

Options :

1.  -ish

2.  -ful

3.  -ly

4.  -ih

   

Question Number : 42 Question Id : 54062620049 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the option that can be used as a one-word substitute for the given group of words. 

 

To send a person back to his own country 

Options :

1.  Immigrate

2.  Emigrate

3.  Migrate

4.  Repatriate

   

Question Number : 43 Question Id : 54062620050 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the most appropriate option to fill in the blank. 

 

My mother complains that I always _______ a mess when I cook.  

Options :

1.  get

2.  make



3.  have

4.  do

   

Question Number : 44 Question Id : 54062620051 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the most appropriate option to fill in the blanks. 

 

Photoreception is activation of a biological _______ by light. Most organisms including man _______ 

to light. Some animals react to light waves not _______ by man. 

Options :

1.  procedure; react; used

2.  reaction; address; seen

3.  progression; retort; professed

4.  process; respond; perceived

   

Question Number : 45 Question Id : 54062620052 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the option that can be used as a one-word substitute for the given group of words. 

 

A thing that existed before or logically precedes another 

Options :

1.  Subsequent

2.  Antecedents

3.  Consequent

4.  Successive

   

Question Number : 46 Question Id : 54062620053 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33



Select the most appropriate synonym of the given word. 

 

Condone 

Options :

1.  Forgive

2.  Remember

3.  Enumerate

4.  Calculate

   

Question Number : 47 Question Id : 54062620054 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the most appropriate synonym of the given word. 

 

Pernicious 

Options :

1.  Judicious

2.  Visceral

3.  Ingenuous

4.  Detrimental

   

Question Number : 48 Question Id : 54062620055 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the most appropriate synonym of the underlined word. 

 

Experimental work shows that the mortality in animals decreases if the fever is untreated, and that 

elevated temperatures can enhance certain aspects of the immune response.  

Options :

1.  demolition

2.  degeneration



3.  subversion

4.  fatality

   

Question Number : 49 Question Id : 54062620056 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the option that can be used as a one-word substitute for the given group of words. 

 

Something that is short-lived; that does not last for a long time 

Options :

1.  Ephemeral

2.  Eternal

3.  Perpetual

4.  Intermittent

   

Question Number : 50 Question Id : 54062620057 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the option to complete the collocation in the given sentence: 

 

I am going out to get some vegetables for dinner tonight. Will you please ______ an eye on the rice 

cooker?  

Options :

1.  take

2.  keep

3.  have

4.  make

   

Question Number : 51 Question Id : 54062620058 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33



Select the most appropriate ANTONYM of the given word. 

 

Ostentatious 

Options :

1.  Showy

2.  Fragrant

3.  Modest

4.  Grand

   

Question Number : 52 Question Id : 54062620059 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the most appropriate verb form of the words given in the brackets to fill in the blanks. 

 

When you ________ (write) this article, make it more descriptive. That will make it ________ (interest) 

to read. 

Options :

1.  written; interested

2.  writing; interesting

3.  pre-write; interested

4.  rewrite; interesting

   

Question Number : 53 Question Id : 54062620060 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the most appropriate ANTONYM of the underlined word. 

 

Stimulation of the anterior hypothalamus by excess heat causes sweating.

Options :

1.  ulterior 

2.  posterior 



3.  interior 

4.  exterior 

   

Question Number : 54 Question Id : 54062620061 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following idioms would suit the following situation? 

 

I saw my college friend today. Once, we were best friends but after a misunderstanding we 

stopped talking. Though it was nice seeing him again, we can never go back to our earlier 

relationship.  

Options :

1.  You can’t judge a book by its cover

2.  Get out of hand

3.  Back to the drawing board

4.  That ship has sailed

   

Question Number : 55 Question Id : 54062620062 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the most appropriate conjunction to fill in the blank. 

 

_______ I was hungry, I did not eat my lunch.  

Options :

1.  Since

2.  Although

3.  As

4.  But

   

Question Number : 56 Question Id : 54062620063 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical



Correct Marks : 1 Wrong Marks : 0.33

Select the option that will complete the given conditional. 

 

If I had known about the impending crisis, ________________. 

Options :

1.  I would have made appropriate arrangements

2.  I will make appropriate arrangements

3.  I would make appropriate arrangements

4.  I wouldn’t make appropriate arrangements

   

Question Number : 57 Question Id : 54062620064 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the most appropriate prepositions to fill in the blanks. 

 

Coloured bands _______ soap bubbles and oil layers are caused _____ interference of light waves 

_______ themselves. 

Options :

1.  in; on; by

2.  on; by; with

3.  of; to; on

4.  into; in; to

   

Question Number : 58 Question Id : 54062620065 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the grammatically INCORRECT sentence from the given options.

Options :

1.  Women’s education is the key to a better life in the future.

2.  Children working in hazardous industries are prone to debilitating conditions which can 

cripple them for life.



3.  Psychologists say that parents who overindulge their kids set them up to be more vulnerable 

to future anxiety and depression.

4.  Trees provides a home for wild animals they produce many kinds of timber.

   

Question Number : 59 Question Id : 54062620066 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the most appropriate pronouns to fill in the blanks. 

 

Although _______ in the classroom was able to understand _______ said by the lecturer, no student 

complained. 

Options :

1.  anyone; anything

2.  someone; nothing

3.  a few; nothing

4.  no one; anything

   

Question Number : 60 Question Id : 54062620067 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Select the most appropriate option to fill in the blanks. 

 

Vidya _______ for Netherlands for her higher studies last month itself. She must _______ her 

university by this time. 

Options :

1.  had left; joined

2.  left; have joined

3.  has left; have joined

4.  leaves; joins

   

   



Data Analysis Data Interpretation & Data Sufficiency
Section Id : 5406261002

Section Number : 5

Section type : Online

Mandatory or Optional : Mandatory

Number of Questions : 5

Number of Questions to be attempted : 5

Section Marks : 5

Enable Mark as Answered Mark for Review and 

Clear Response :
Yes

Sub-Section Number : 1

Sub-Section Id : 5406261203

Question Shuffling Allowed : Yes

   

Question Number : 61 Question Id : 54062620068 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

The following bar graph gives a detailed picture of the number of laptops and desktops sold by a 

showroom in various years from 2015 to 2020 (In thousands).  

 

 

 



What is the difference between the percentage increase in the number of desktops sold in the 

year 2019 and the number of laptops sold in the year 2018?

Options :

1.  46.67 percent

2.  53.25 percent

3.  75.65 percent

4.  35.68 percent

   

Question Number : 62 Question Id : 54062620069 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

The following chart gives information regarding the percentage distribution of fans of various IPL 

teams among a colony. 

 

 

 

If the total number of residents in the colony is 6000, then what is the ratio of the number of fans 

of SRH and the number of fans of CSK?

Options :

1.  1 : 3

2.  2 : 4

3.  3 : 1

4.  4 : 2



   

Question Number : 63 Question Id : 54062620070 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

The following chart gives information related to the number of various drinks sold by 5 

shopkeepers A, B, C, D, E. 

 

 

 

What is the sum of the average number of Pepsis and Mirindas sold by the 5 shopkeepers?

Options :

1.  720

2.  700

3.  730

4.  750

   

Question Number : 64 Question Id : 54062620071 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

The following line graph shows the prices of 3 vegetables Onions, Potatoes and Tomatoes from 

2015 to 2019. 

 



 

 

What is the percentage increase in the price of Potatoes from the year 2016 to 2019?

Options :

1.  16.47 percent

2.  24.44 percent

3.  29 percent

4.  20 percent

   

Question Number : 65 Question Id : 54062620072 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

The following pie chart gives a detailed study about the laptop sales in a shop in the month of 

May.  

 

 

 



If the total number of laptops that are sold in May is 700, then what is the sum of the number of 

Asus and Dell laptops sold?

Options :

1.  255

2.  235

3.  225

4.  245

   

   

Computer Proficiency (MS-Office)
Section Id : 5406261003

Section Number : 6

Section type : Online

Mandatory or Optional : Mandatory

Number of Questions : 20

Number of Questions to be attempted : 20

Section Marks : 20

Enable Mark as Answered Mark for Review and 

Clear Response :
Yes

Sub-Section Number : 1

Sub-Section Id : 5406261204

Question Shuffling Allowed : Yes

   

Question Number : 66 Question Id : 54062620073 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following is a piece of text or an image in an electronic document that can connect 

readers to another portion of the document or a different webpage, when using MS-Word 2016?

Options :

1.  Cross-reference



2.  Mail Merge

3.  Hyperlink

4.  Macros

   

Question Number : 67 Question Id : 54062620074 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following options of MS-Word 2010 sends a document directly to the default printer 

without making changes?

Options :

1.  Print

2.  Quick Print

3.  Print Preview

4.  Fast Print

   

Question Number : 68 Question Id : 54062620075 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following change case commands is NOT available in the Font group of the home tab 

in MS-Word 2016?

Options :

1.  Lower case

2.  Upper case

3.  Toggle case

4.  Paragraph case

   

Question Number : 69 Question Id : 54062620076 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following commands of the Illustrations group in the Insert tab is used to insert 



drawings, movies, sounds or stock photography to demonstrate a specific concept in MS-Word 

2007?

Options :

1.  Clip Art

2.  Picture

3.  Shapes

4.  SmartArt

   

Question Number : 70 Question Id : 54062620077 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following options of the Format tab that appears with Drawing Tools is used to fill a 

selected shape with solid color, gradient, picture or texture in MS-Word 2016?

Options :

1.  Shadow Effects

2.  3-D Effects

3.  Shape Styles

4.  Shape Fill

   

Question Number : 71 Question Id : 54062620078 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following options from the Page Setup group in the Layout tab is used to switch the 

pages between landscape and portrait layouts in MS-Word 2016?

Options :

1.  Margins

2.  Orientation

3.  Hyphenation

4.  Watermark

   



Question Number : 72 Question Id : 54062620079 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following tabs of MS-Excel 2016 contains features such as adding external data (from 

the web), filtering options and data tools etc.?

Options :

1.  Home

2.  Formulas

3.  Data

4.  Review

   

Question Number : 73 Question Id : 54062620080 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following statements is FALSE with reference to MS-Excel 2016?

Options :

1.  The sheet on which you work is called a ‘document’.

2.  Multiple worksheets can be added in a single Excel file.

3.  MS-Excel is also a data processing application.

4.  An MS-Excel file is saved with the extension ‘.xlsx’.

   

Question Number : 74 Question Id : 54062620081 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following shortcut keys in MS-Excel 2013 is used to close a workbook?

Options :

1.  Alt+W 

2.  Alt+H 

3.  Ctrl+S 

4.  Ctrl+W 



   

Question Number : 75 Question Id : 54062620082 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

In MS-Excel 2016, 'Ctrl+O' is used ________. 

Options :

1.  to open a workbook

2.  to close a workbook

3.  to save a workbook

4.  to remove all contents

   

Question Number : 76 Question Id : 54062620083 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following displays both, the name of the application and the name of the 

spreadsheet in MS-Excel 2007?

Options :

1.  Menu bar

2.  Title bar

3.  Tool bar

4.  Task bar

   

Question Number : 77 Question Id : 54062620084 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following statements is true with reference to MS-Excel 2016?

Options :

1.  The status bar is used to access various commands in Excel.

2.  MS-Excel is a powerful database program.

3.  Ctrl+S is used to open the Print dialogue window



4.  The Chart command is available in the Insert tab

   

Question Number : 78 Question Id : 54062620085 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

In which of the following menus are the Page setup options usually available in MS-Excel 2013?

Options :

1.  Insert

2.  Home

3.  Page Layout

4.  Review

   

Question Number : 79 Question Id : 54062620086 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Pie charts are used to display which of the following in MS-Excel 2016?

Options :

1.  Comparing multiple values

2.  Displaying trends over time

3.  Comparing values across categories

4.  The contribution of each value to the total

   

Question Number : 80 Question Id : 54062620087 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following is the file extension for an MS-PowerPoint 2016 file?

Options :

1.  .PPT

2.  .PPTX

3.  .PTX



4.  .PDF

   

Question Number : 81 Question Id : 54062620088 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following shortcut keys is used to create a new presentation in MS-PowerPoint 2016?

Options :

1.  Ctrl+M 

2.  Ctrl+B 

3.  Ctrl+N 

4.  Ctrl+X 

   

Question Number : 82 Question Id : 54062620089 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following views of MS-PowerPoint 2013 is used to edit the speaker notes as they will 

look when we print them out?

Options :

1.  Slide Show

2.  Slide Master

3.  Slide Sorter

4.  Notes Page

   

Question Number : 83 Question Id : 54062620090 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

Which of the following in MS-PowerPoint 2016 allows access to common commands no matter 

which tab is selected?

Options :

1.  Quick Print



2.  Quick Access Toolbar

3.  Dialog Box Launcher

4.  Ruler

   

Question Number : 84 Question Id : 54062620091 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

The 'Fly In' option belongs to which of the following Add Effect categories in Custom Animation in 

MS-PowerPoint 2016?

Options :

1.  Entrance

2.  Emphasis

3.  Exit

4.  Motion paths

   

Question Number : 85 Question Id : 54062620092 Question Type : MCQ Option Shuffling : Yes 

Is Question Mandatory : No Option Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0.33

The Themes group is found in which of the following tabs in MS-PowerPoint 2016?

Options :

1.  Slide show

2.  Animation

3.  Design

4.  Review


